The Plug-in Architecture of Eclipse

This tutorial will teach you the basics of writing plugins that run inside the Eclipse framework. You will learn about editors, views, and extension points by
creating one of each yourself. Once you're done with this tutorial, you will have an application that will look something like this:
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You may want to download the slides of the presentation explaining the basic concepts you will explore in this tutorial.

® Preliminaries
® Required Software
® General Remarks
® Finding Documentation
® Preparing the Repository
® Creating a Simple Text Editor
® Creating a New Plugin
® Create the Main Editor Class
® Register the Editor
® Test the Editor
® Creating a Simple View
® Creating the View Class
Create the View Extension
Add Content and Label Providers
Use Simple Text Editor as Tape View Input
Create Actions to Move the Tape Head
® Test the View
® Creating an Extension Point
® Defining a Command Class
Defining the Controller Interface
Defining the Extension Point
Accessing the Extension Point
Adding Support for Head Controllers to the View
Adding a Test Head Controller
® |Implementing Your Own Head Controller
® Congratulations!

Preliminaries

There's a few things to do before we dive into the tutorial itself. For example, to do Eclipse programming, you will have to get your hands on an Eclipse
installation first. Read through the following sections to get ready for the tutorial tasks.

Required Software

For this tutorial, we need you to have Eclipse and Git installed:


https://rtsys.informatik.uni-kiel.de/confluence/download/attachments/2982234/presentation.pdf?version=1&modificationDate=1351100970000&api=v2

1. Install Eclipse. For what we do, we recommend installing the Eclipse Modeling Tools, with a few extras. Our Wiki page on getting Eclipse has the
details: simply follow the instructions for downloading and installing Eclipse and you should be set.
2. You should already have obtained a working Git installation for the first tutorial.

General Remarks

Over the course of this tutorial, you will be writing a bit of code. Here's a few rules we ask you to follow:

® All your Java code should be in packages with the prefix de. cau. cs. rt prak. | ogi n, where | ogi n is your login name as used for your email
address at the institute. From now on, this rule will apply to all tutorials. Once we start with the actual practical projects, we will choose another
package name.

® All Java classes, fields, and methods should be thoroughly commented with the standard Javadoc comment format. Javadoc comments are well
supported by Eclipse, providing code completion, syntax highlighting, and further features to help you. The code inside your methods should also
be well commented. Try to think about what kinds of information would help someone unfamiliar with your code understand it.

® As you will already have noticed during the first tutorial, our tutorials use Turing machines as the underlying theme. This is partly because we're
computer scientists and computer scientists are expected to choose computer sciency examples, but mostly because Turing machines work great
as examples for the different kinds of topics we will be covering with you. You may thus want to take some time to read up again on the topic. Wiki
pedia or the material of your Theoretical Computer Science lecture might be a great start.

® During this tutorial, we will be using Git mostly from the command line instead of using Eclipse's built-in Git support. This is because we've found
Eclipse's Git support to be too unstable and buggy for us to trust it completely.

Finding Documentation

During the tutorial, we will cover each topic only briefly, so it is always a good idea to find more information online. Here's some more resources that will
prove helpful:

® Java Platform, Standard Edition 6 API Specification
As Java programmers, you will already know this one, but it's so important and helpful that it's worth repeating. The API documentation contains
just about everything you need to know about the API provided by Java6.
® Eclipse Help System
Eclipse comes with its own help system that contains a wealth of information. You will be spending most of your time in the Platform Plug-in
Developer Guide, which contains the following three important sections:
® Programmer's Guide
When you encounter a new topic, such as SWT or JFace, the Programmer's Guide often contains helpful articles to give you a first
overview. Recommended reading.
* References -> API Reference
One of the two most important parts of the Eclipse Help System, the API Reference contains the Javadoc documentation of all Eclipse
framework classes. Extremely helpful.
® References -> Extension Points Reference
The other of the two most important parts of the Eclipse Help System, the Extension Point Reference lists all extension points of the
Eclipse framework along with information about what they are and how to use them. Also extremely helpful.
® Eclipsepedia
The official Eclipse Wiki. Contains a wealth of information on Eclipse programming.
® Eclipse Resources
Provides forums, tutorials, articles, presentations, etc. on Eclipse and Eclipse-related topics.

You will find that despite of all of these resources Eclipse is still not as well commented and documented as we'd like it to be. Finding out how stuff works
in the world of Eclipse can thus sometimes be a challenge. However, this does not only apply to you, but also to many people who are conveniently
connected by something called The Internet. It should go without saying that if all else fails, Google often turns up great tutorials or solutions to problems
you may run into. And if it doesn't, Miro and | will be happy to help you as well.

Preparing the Repository

We have created a Git repository for everyone to do his tutorials in. You can access the repository online through our Stash tool over here. You will first
have to configure your Stash account:

1. Login with your Rtsys account information.

2. Through the button in the top right corner, access your profile.

3. Switch to the SSH keys tab.

4. Click Add Key and upload a public SSH key that you want to use to access the repository.

You should now be able to access the repository. Clone it:
1. Open a console window and navigate to an empty directory that the repository should be placed in.
2. Enter the command ssh://git@it.rtsys.informatik.uni-Kkiel.de:7999/ PRAK/ 12ws- ecl i pse-tutorials.git . (includingthe
final dot, which tells git to clone the repository into the current directory instead of a subdirectory).
3. You should now have a clone of the repository in the current directory.

You will use this repository for all your tutorial work, along with everyone else. To make sure that you don't interfere with each other, everyone will work on
a different branch. This is not exactly how people usually use Git, but goes to demonstrate Git's flexibility... Add a branch for you to work in:

1. Entergit checkout -b |ogin_nane

You have just added and checked out a new branch. Everything you commit will go to this branch. To push your local commits to the server (which you will
need to do so we can access your results), do the following:


https://rtsys.informatik.uni-kiel.de/confluence/display/KIELER/Getting+Eclipse
http://download.oracle.com/javase/1.5.0/docs/tooldocs/windows/javadoc.html#javadoctags
http://en.wikipedia.org/wiki/Turing_machine
http://en.wikipedia.org/wiki/Turing_machine
http://download.oracle.com/javase/6/docs/api/
http://help.eclipse.org/juno/index.jsp
http://wiki.eclipse.org/Main_Page
http://www.eclipse.org/resources/
http://www.google.de
http://git.rtsys.informatik.uni-kiel.de:7990/projects/PRAK/repos/12ws-eclipse-tutorials/browse

1. Entergit push origin |ogin_nanme

You would usually have to enter gi t pul | first, but since nobody will mess with your branch this won't be necessary. By the way, you only need to
mention ori gi n | ogi n_nane with the first gi t push, since Git doesn't know where to push the branch yet. After the first time, Git remembers the
information and it will be enough to just enter gi t push.

Creating a Simple Text Editor

OK, with all the preliminaries out of the way let's get working. Fire up Eclipse, choose an empty workspace, close the Welcome panel it will present you
with and follow the following steps.

Creating a New Plugin

For our text editor to integrate into Eclipse, we need to create a plug-in project for it:

1. New -> Project...

2. In the project wizard, choose Plug-in Project and click Next.

3. As the project name, enter de. cau. cs. rt prak. | ogi n. si npl e. Uncheck Use default location (which would put the project into your
workspace), and put it into your local clone of the Git repository instead (the Location should read something like / pat h/t o/ gi t/ reposi tory
/ de. cau. cs.rtprak. | ogin. sinple). Click Next.

4. As the name, enter Si npl e (I ogi n) . Also, make sure that Generate an activator and This plug-in will make contributions to the Ul are both
checked. Click Finish. (Eclipse might ask you whether you want to switch to the Plug-in Development Perspective, which configures Eclipse to
provide the views that are important for plug-in development. Choose Yes. Or No. It won't have a big influence on your future...)

5. Eclipse has now created your new plug-in and was nice enough to open the Plug-in Manifest Editor, which allows you to graphically edit two
important files of your plugin: pl ugi n. xm and META- | NF/ MANI FEST. MF. (By the way, this would be a great time to research the editor and the
two files online.) Basically, those two files provide information that tell Eclipse what other plug-ins your plug-in needs and how it works together
with other plug-ins by providing extensions and extension points. Our new plug-in will depend on two other plug-ins, so switch to the Dependencies
tab of the editor and add dependencies to or g. ecl i pse. ui . edi tors and or g. ecl i pse. j f ace. t ext . Save the editor and close it. (You
can always reopen it by opening one of the two mentioned files from the Package Explorer.)

6. Tell Eclipse that the project is inside a Git repository. Right-click on the project, click Team, and click Share Project. Select Git as the repository
type and click Next. The repository information should appear and you should be able to simply click Finish.

Create the Main Editor Class

We will now create the class that implements the simple text editor. There won't be any programming involved here since we're lazy; instead, we will just
inherit from an existing simple text editor.

1. New -> Class.
2. Package: de. cau. cs. rtprak. | ogi n. si npl e. edi t ors. Name: Si npl eEdi t or Par t . Superclass: or g. ecl i pse. ui . editors. text.
Text Edi t or . Click Finish.

Register the Editor
For the editor to be available inside Eclipse, we will have to register it by adding an extension to an extension point.

1. Copy the attached file to a new subfolder icons in the plug-in folder (right-click the plug-in folder in the Package Explorer and choose New -> Folde
r...). You can copy the file by importing it from inside Eclipse (File -> Import... -> File System) or by copying it from outside Eclipse and refreshing
the plug-in project afterwards (right-click the plug-in folder in the Package Explorer and choose Refresh).

. Open the Plug-in Manifest Editor again and switch to the Extensions tab.

. Click Add..., choose the or g. ecl i pse. ui . edi t or s extension point and click Finish.

4. The extension point is now shown in the list of extensions, along with an editor extension. Select that extension and edit its details using the fields
on the right. Set the ID to de. cau. cs. rt prak. | ogi n. si npl e. edi t or, the name to Si npl e Text Editor,theicontoicons/turing-
file.gif,the extensions to si npl e, the class to de. cau. cs. rt prak. | ogi n. si npl e. edi t ors. Si npl eEdi t or Part, and the default to t
rue.

5. Save the manifest editor.

w N

Test the Editor

It's time to test your new simple editor in a new Eclipse instance.

1. Switch back to the Overview tab of the Plug-in Manifest Editor.
2. Click Launch an Eclipse Application.
® For future tests, you can now select Eclipse Application in the run menu.
® To enable debug mode for your test instances: open the Run Configurations dialog, select the Arguments tab of the Eclipse Application
configuration, and add -debug -consoleLog as program arguments. This dumps all errors and exceptions to the console view, so you can
directly see what went wrong.
® To improve performance, select only the plugins that are necessary: in the Plug-ins tab select Launch with plug-ins selected below only,
deselect Target Platform, select Workspace, and then Add Required Plug-ins.
® Make sure that org.eclipse.ui.ide.application is also selected, else you won't be able to launch Eclipse.
® The requirements list needs to be updated when the dependencies of your plugins have changed; click Add Required Plug-ins
again for updating.
3. In the new Eclipse instance, click New -> Project... -> General -> Project. Enter t est as the project name.
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4. Right-click the new project and click New -> File... As the file name, enter t est . si npl e. This will create a new file with that name and open the
file in your newly added text editor. (You can see that it is your editor by looking at the editor icon, which should look like the icon you downloaded
and put into the icons folder.)

Creating a Simple View

The next task consists of creating a view that is able to display the state of a Turing Machine. We will do this using a table with one column, where each
row represents an entry on the tape of the Turing Machine. The tape shall be infinite to one side, and the position of the read/write head shall be movable
by two buttons. The content of the tape shall be determined by the currently active instance of our simple text editor.

@ Hint
In the following, we will be making use of the Standard Widget Toolkit (SWT) and JFace to build a user interface. It might be a good idea now to
search for an introduction to SWT and JFace concepts on the Internet before you proceed.

Creating the View Class
We will start by creating a class that will define the view.

1. Create a class TapeVi ewPart in a new package de. cau. cs. rt prak. | ogi n. si npl e. vi ews that extends the ViewPart class. (make sure
that in the New Java Class wizard, the option Inherited abstract methods is checked.)

2. Add a private field t abl eVi ewer of type TableViewer.

3. Your Tabl eVi ewPar t contains a still empty method cr eat ePar t Cont r ol . This method will be responsible for creating the user interface
components of your view. Add the following code to create the table we want to display:

Tabl e tabl e = new Tabl e(parent, SWI. BORDER);

tabl e. set Header Vi si bl e(true);

Tabl eCol um col uim = new Tabl eCol unm(t abl e, SWI. NONE) ;
col um. set W dt h(80) ;

col um. set Text (" Tape Data");

tabl eVi ewer = new Tabl eVi ewer (tabl e);

4. The set Focus method controls what happens when your part gets the focus. Make sure the focus will then automatically be set to the table by
adding the following code:

t abl eVi ewer. get Control (). set Focus();

Create the View Extension

We will now have to register our new view with Eclipse so that it can be seamlessly integrated into the workbench.

1. Copy the three files tape_head.gif, head_present.gif, and head_absent.gif to the i cons subfolder of your plug-in as you did it before. (You might
need to refresh your project again if you did the copying outside of Eclipse.)

2. Open the pl ugi n. xni file in the Plugin Manifest Editor and switch to the Extensions tab.

3. Click Add to add a new extension for the extension point or g. ecl i pse. ui . vi ews. Right-click the newly added extension and add a new vi ew
element through the New menu.

4. Set the view element's properties as follows: ID de. cau. cs. rt prak. | ogi n. si npl e. vi ew, name Tape, class de. cau. cs. rt prak. | ogi n.
si npl e. vi ews. TapeVi ewPar t , category or g. ecl i pse. ui , iconi cons/tape_head. gi f.

When you start the application, you should now be able to open your view by clicking Window -> Show View -> Other.

Add Content and Label Providers

The idea of JFace viewers is to abstract a bit from the underlying widget (in our case, the table) and instead work on data models that are to be viewed.
Instead of adding items to the table directly, the table viewer is supplied with an input object, a content provider, and a label provider. The content provider
allows the viewer to make sense of the input object and basically allows the viewer to access the input object's data. The label provider translates each
item of data into text and icons that can be used to present the item to the user in the table.

We will now create content and label providers to do just that.

1. Create aclass Turi ngTape in a new package de. cau. cs. rt prak. | ogi n. si npl e. nodel with the following fields:

private int headPosition = 1;
private StringBuffer text = new StringBuffer();
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Also add corresponding getter and setter methods. (You can simply right-click somewhere in the class and choose Source -> Generate Getters
and Setters.)
2. Add two constants to the class:

public static final char START_CHAR
public static final char BLANK_CHAR

'\ u25b7';
"\u25fb';

3. Add a method get Char act er (i nt pos) that calculates the tape character at position pos as follows:
® Forpos == 0, return the character START_CHAR.
® Forpos > text.length(), return the character BLANK_CHAR.
® Otherwise, return the text character at index pos - 1.
4. Add a private field tape of type Turi ngTape to TapeVi ewPar t and initialize it with a new instance.
5. Create a class TapeDat a in de. cau. cs. rt prak. | ogi n. si npl e. nodel with two fieldsi nt i ndex and char character, and add a
constructor for initialization as well as corresponding getter methods.
6. Create a class TapeCont ent Provi der inthe de. cau. cs. rt prak. | ogi n. si npl e. vi ews package that implements IStructuredContentProvi
der.
® The methods di spose() and i nput Changed() may remain empty.
® The method get El enent s() must return an array of objects, where each object must contain all necessary data to be displayed in a
single row of the table. The number of returned objects corresponds to the number of rows.
® Suppose the input element is an instance of Tur i ngTape. The result of get El enent s() shall be an array of TapeDat a elements. The
size of the array shall be one more than the maximum of the tape head position and the length of the tape text. The index and character
of each tape data element shall be filled with i and the result of t uri ngTape. get Char act er (i ), respectively, where i is the array
index of the element.
7. Create a class TapelLabel Provi der inthe de. cau. cs. rt prak. | ogi n. si npl e. vi ews package that extends BaselLabelProvider and
implements ITableLabelProvider.
® Add a private field t ape of type Tur i ngTape that is initialized from the constructor.
® Add fields pr esent | mage and absent | nage of type Image.
® |nitialize each image using the following code, where pat h_t o_i nage isi cons/ head_present . gi f andi cons/ head_absent . gi f
, respectively:

i mge = Activator.inmageDescriptorFronPl ugi n(Activator. PLUG N_ID, "path_to_inage").createl mage();

® Qverride the implementation of di spose() in TapeLabel Provi der to dispose both images after calling super . di spose() . (Right-
click in the source-code and click Source -> Override/Implement Methods.)
® |nget Col uml mage() and get Col uimText (), first check whether the element is an instance of TapeDat a and the column index is
0, and return nul | otherwise. If the check passes, return the following:
® get Col uml mage() : pr esent | mage if the index given by the tape data element equals the current value of t ape.
get HeadPosi ti on(), absent | mage otherwise.
® get Col umText ():a Stri ng containing the character of the tape data element.
8. Add the following lines to cr eat ePart Control () in TapeVi ewPart :

t abl eVi ewer . set Cont ent Provi der (new TapeCont ent Provi der ());
t abl eVi ewer . set Label Provi der (new TapeLabel Provi der (tape));
tabl eVi ewer . set | nput (tape);

Use Simple Text Editor as Tape View Input
We will now add code to make the Tape view display the content of a currently active Simple Text Editor.

1. Add the following methods to Si npl eEdi t or Part :
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/**
* Returns the text that is currently displayed in the editor.
* @eturn the currently displayed text
*/
public String getText() {
return get Docunent Provi der (). get Docunent (get Edi tor I nput()).get();
}
/** The listener that is currently registered for this editor. */
private | DocunentLi stener registeredListener;
/**
* Registers the given runnable as listener for changes to the text
* of this editor.
* @aramrunnable a runnable to register as text |istener
*/
public void registerTextListener(final Runnable runnable) {
regi st eredLi stener = new | Docunent Li stener() {
public voi d docunent About ToBeChanged( Docunent Event event) {}
public void docunment Changed( Docunent Event event) {
runnabl e. run();
}
b
get Docunent Provi der () . get Docunent (get Edi t or I nput ())
. addDocunent Li st ener (r egi st er edLi st ener);
}

| **

* Renpves the last registered text |istener.

*/
public void di sposeTextListener() {
if (registeredListener !'= null) {
if (getDocumentProvider() !'= null) {
get Docunent Provi der (). get Docunent (get Edi t or | nput () )
.renoveDocunent Li st ener (regi st er edLi st ener);
}
regi steredLi stener = null;
}
}

2. Add the following code to TapeVi ewPart :

/** The editor part that is currently set as input for the viewer. */
private SinpleEditorPart currentlnput;
/**
* Sets the displayed text of the given editor part as input of the
* viewer, if the editor part is a SinpleEditorPart.
* @aram part workbench part to set as input
*/
private void setlnput(final |WrkbenchPart part) {
if (part instanceof SinpleEditorPart &% part != currentlnput) {
if (currentlinput !'= null) {
current | nput. di sposeText Li stener();
}
currentlnput = (SinpleEditorPart) part;
Runnabl e runnabl e = new Runnabl e() {
public void run() {
t ape. set Text (new StringBuffer(currentlnput.getText()));
tabl eViewer.refresh();
}
b
runnabl e. run();
currentlnput.registerTextListener(runnable);

3. Add the following code to cr eat ePart Control ():



I Wor kbenchW ndow wor kbenchW ndow = get Site(). get Wr kbenchW ndow() ;

| Wor kbenchPage activePage = wor kbenchW ndow. get Act i vePage() ;

if (activePage != null) {

set | nput (acti vePage. get ActivePart());

}

wor kbenchW ndow. get Par t Servi ce() . addPart Li stener(new | PartLi stener() {
public void partActivated(final |WrkbenchPart part) {

set I nput (part);

}
public void partDeactivated(final |WrkbenchPart part) {}
public void partBrought ToTop(final |WrkbenchPart part) {}
public void partd osed(final |WrkbenchPart part) {}
public void partQpened(final |WrkbenchPart part) {}

3

Create Actions to Move the Tape Head

If we want to add buttons to the view's tool bar, we will have to ask its IToolbarManager to do that for us:

1. Get the tool bar manager using the following code:

| Tool Bar Manager t ool Bar Manager = get Vi ewSite().getActionBars().getTool Bar Manager () ;

2. Add two actions to the toolbar manager by extending the class Action and implementing the r un(') method.
® |tis convenient to add actions as anonymous nested classes.
® The first action shall have the text "L". When it is run, it shall move the head to the left (to the top in the table viewer), if the head is not
already at position 0.
®* The second action shall have the text "R". When it is run, it shall move the head to the right.
® You should call t abl eVi ewer . ref resh() after any change to the t ape. headPosi t i on variable.

Test the View

If you open an instance of the simple text editor and open the Tape view, the view should correctly display the editor's text on a tape, and the L and R
buttons should move the tape head.

Creating an Extension Point

For the final part of the tutorial, we will now use the extension point mechanism of Eclipse to add some behavior to our Turing Machines. An extension point
is basically a well-defined point where other plug-ins can register to add functionality. The extension point is basically defined by an XML Schema file that
defines an interface; other plug-ins may access this interface using XML code in their pl ugi n. xni file, so-called extensions. Our extension point will
provide an interface for classes that define behavior of a Turing Machine, and we will call them head controllers (programs that control the tape head).

Defining a Command Class

We will start by defining a class representing a command that will be passed to a selected head controller.

. Add a class HeadCommand to the package de. cau. cs. rt prak. | ogi n. si npl e. control | er.
. Add a nested public static enumeration Act i on with values Rl TE, ERASE, and NULL.

. Add a nested public static enumeration Di r ect i on with values LEFT, Rl GHT, and NONE.

. Add the following private fields:
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private Action action;
private Direction direction;
private char newChar;

5. Add a constructor to initialize the fields.
6. Add getter methods to access the fields.

Defining the Controller Interface

We will now define an interface that all head controllers will have to implement:

1. Add an interface | HeadCont r ol | er in the package de. cau. cs. rtprak. | ogi n. si nmpl e.controller.
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2.

Add the following methods to the interface:

/**

* Cal cul ate the next comrand depending on the currently seen character.
* @aram character the currently seen character

* @eturn the next conmmand specifying which character to wite and

* which direction to nove the head

*/

HeadCommand next Command( char character);

/**

* Reset the internal state of the head controller.
*/

void reset();

Defining the Extension Point

We will now define the extension point that head controllers will be registered at.

1.
2.
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Open the pl ugi n. xni file in the Plugin Manifest Editor and switch to the Extension Points tab.

Click the Add button and enter de. cau. cs. rt prak. | ogi n. si npl e. headControl | er s as the extension point's ID, and Head

Control | er s as its name. Shorten the schema file's file name to schenma/ headCont rol | er s. exsd. Make sure that Edit extension point
schema when done is checked and click Finish.

. Eclipse will now have opened the new schema file in the Extension Point Schema Editor, a graphical editor similar to the Plugin Manifest Editor

that provides a way to define things that might be easier than directly editing the text files.

. In the new editor, open the Definition tab.
. Add a new element named control | er.
. Add three new attributes to the cont r ol | er element:

® First attribute: name i d, use r equi r ed, type st ri ng, translatable f al se.

® Second attribute: name nane, use r equi r ed, type st ri ng, translatable t r ue.

® Third attribute: name cl ass, use r equi r ed, type j ava, implements de. cau. cs. rt prak. | ogi n. si npl e. control |l er.
| HeadCont r ol | er. This is the attribute that will tell us which Java class actually implements the controller that is to be registered at our
extension point. To make sure that we know how to speak to the class, we require it to implement the interface we defined for head
controllers.

. Add a sequence to the ext ensi on element. Right-click the sequence and click New -> controller. Set the Min Occurrences of the sequence to 0,

and set Max Occurrences to be Unbounded.

. Save the editor and switch back to the Plugin Manifest Editor.
. On the Runtime tab, add de. cau. cs. rt prak. | ogi n. si npl e. control | er to the list of packages exported by the plug-in. This is necessary

because plug-ins that want to provide extensions for the extension point must provide a class that implements | HeadCont r ol | er . For this to
work, those plug-ins must have access to that interface; thus, we have to export the package containing it.

Accessing the Extension Point

We will now add a class that will be in charge of loading all extensions registered at our new extension point.

1.

Add a class HeadCont r ol | er s to the package de. cau. cs. rt prak. | ogi n. si npl e. control | er. Add the following code, replacing | ogi n
with your login name in EXTENSI ON_PO NT_I D as usual:



/**
* O ass that gathers extension data fromthe 'headControllers' extension point
* and publishes this data using the singleton pattern.
* @ut hor nsp
*/
public class HeadControllers {
/** ldentifier of the extension point */
public final static String EXTENSION_PO NT_I D = "de. cau. cs.rtprak. | ogin.sinple.headControl | ers";
/** The singleton instance of the {@ode HeadControllers} class */
public final static HeadControllers | NSTANCE = new HeadControllers();
/** list of head controller ids with associated nanes. */
private List<String[]> controllerNanmes = new Li nkedLi st<String[]>();
/** map of controller ids to their runtine instances. */
private Map<String, |HeadController> controllerMap = new HashMap<String, |HeadController>();
/**
* Creates an instance of this class and gathers extension data.
*/
HeadControllers() {
| ConfigurationEl ement[] elenents = Pl atform get Ext ensi onRegi stry()
. get Confi gurati onEl ement sFor (EXTENSI ON_PO NT_I D) ;
for (IConfigurationEl ement elenment : elenents) {
if ("controller".equal s(el ement.getNanme())) {
String id = elenent.getAttribute("id");
String nane = el enment.getAttribute("name");
if (id!=null & name !'= null) {
try {
| HeadControl l er controller = (l1HeadController)el enent
. creat eExecut abl eExt ensi on("cl ass");
control | er Nanmes. add(new String[] {id, nane});
control l erMap. put (id, controller);
}
catch (CoreException exception) {
St at usManager . get Manager () . handl e( exception, Activator.PLUG N_ID);

}

}

/**
* Returns a list of controller ids and nanes. The arrays in the list are
* all of size 2: the first elenent is an id, and the second el enent is the
* associ ated nane. The controller name is a user-friendly string to be
* displayed in the U.
* @eturn a list of controller ids and nanes
*/
public List<String[]> getControllerNanmes() {
return controll erNanes;

}

/**

* Returns the head controller instance for the given id.

* @aramid identifier of a head controller

* @eturn the associated controller

*/

public | HeadController getController(final String id) {
return controllerMp. get(id);

}

Adding Support for Head Controllers to the View

We will now have to add support for head controllers to our view.

1. Open the TapeVi ewPart class and add the private fields checkedCont r ol | er Act i on of type IAction and cur rent Control | er of type | Hea
dController.


http://help.eclipse.org/juno/topic/org.eclipse.platform.doc.isv/reference/api/org/eclipse/jface/action/IAction.html

2. Add a list of registered head controllers to the view's menu (which can be opened using the small white triangle) in the cr eat ePar t Cont r ol ()
method:

| MenuManager nmenuManager = getViewSite().getActionBars().get MenuManager();
for (String[] controllerNane : HeadControllers. | NSTANCE. get Control |l erNames()) {
final String id = controllerNane[0];
String name = controllerNane[1];
Action action = new Action(name, |Action.AS _RADI O BUTTON) {
public void run() {
if (checkedControllerAction !'= null) {
checkedControl | er Acti on. set Checked(f al se);
}
thi s. set Checked(true);
checkedControl |l erAction = this;
currentControl l er = HeadControll ers. | NSTANCE. get Control I er (id);

}

b

if (checkedControllerAction == null) {
action.run();

}

menuManager . add(acti on);

3. Implement the following method in the Tur i ngTape class:

public void execute(final |HeadController controller)

The method shall have the following properties:

* Determine the character at the current head position using get Char act er ( get HeadPosi tion()).

® Callcontroller.next Command() with the current character as parameter.

* Depending on the action in the returned head command, either write the returned new character to the current position in text (WRl TE),
or write the blank symbol (ERASE), or do nothing. If the current position exceeds the end of the text, append enough blank characters up
to the current position, then append the new character.

® Depending on the direction in the returned head command, either move the head to the left (but no further than position 0), or to the
right, or do nothing.

4. Copy the files step.gif and reset.qgif to the icons folder.
5. Add an action to the toolbar of the Tape view with text St ep and icon st ep. png which does the following:

® Check whether the current head controller is not nul | , than call t ape. execut e(current Control l er).

* Refresh the table viewer with its r ef r esh() method.

® Note: actions don't need images, but only image descriptors. Thus, to set the action's icon to st ep. png, you can use something like the
following:

Acti vator.inmageDescri ptor FronPl ugi n(Activator. PLUG N_ID, "path_to_icon");

6. Add another action with text Reset and icon reset.png which does the following:
® Check whether the current head controller is not nul | , then call the r eset () method on current Control | er.

® Set the current head position to 1.
® Refresh the table viewer with its r ef r esh() method.

Adding a Test Head Controller
Before creating a proper head controller in another plug-in, we will add a test controller to check whether all this stuff works.

1. Add anewclass Nul | Control | er tothe de. cau. cs. rtprak. | ogin.sinple.controllers package:


https://rtsys.informatik.uni-kiel.de/confluence/download/attachments/2982234/step.gif?version=1&modificationDate=1351099370000&api=v2
https://rtsys.informatik.uni-kiel.de/confluence/download/attachments/2982234/reset.gif?version=1&modificationDate=1351099373000&api=v2

/**
* Head controller that does nothing, for testing.
* @ut hor msp

*/
public class Null Controller inplenents | HeadController {
/**
* {@nheritDoc}
*/
publ i ¢ HeadCommand next Command(final char character) {
return new HeadCommand( Action. NULL, Direction.NONE, '_');
}
/**
* {@nheritDoc}
*/
public void reset() {
}
}

2. Open the Plugin Manifest Editor and switch to the Extensions tab. Add your de. cau. cs. rt prak. | ogi n. si npl e. headControl |l ers
extension point. Add a cont r ol | er element with ID de. cau. cs. rt prak. | ogi n.sinple.null Controller,nameNull Controller,
and class de. cau. cs. rtprak. | ogin.sinple.controller.Null Controller.

3. Start the application and observe how your program behaves if you change the action and direction in the Nul | Cont r ol | er class. You can
actually change both while the application is running, but only if you have started it in the Debug mode. In that case, Eclipse will actually hot-swap
your changes into the running application. Sorcery!

Implementing Your Own Head Controller
We will now create a new plug-in with a new head controller:

1. Create a new plug-in de. cau. cs. rt prak. | ogi n. si npl e. ext ensi on. (Remember to create the project in your Git repository.) In the Plugin
Manifest Editor, add de. cau. cs. rt prak. | ogi n. si npl e to the dependencies of the new plug-in.
2. Create a new class that implements | HeadCont rol | er:
® Assuming that the initial head position is 1, the controller shall copy the input text infinitely often. So if the tape initially contains the word h
el | o, the controller shall generate hel | ohel | ohel | ohe. . . .
® Your class needs some private fields to store the internal state of the controller, and you may need some special character as marker.
Imagine how a Turing Machine would do this.
® |tis not allowed to store data that can grow infinitely, since a Turing Machine may only have a finite number of states. This means that
you may store single characters or numbers, but you must not store Strings, StringBuffers, arrays, lists, or sets.
3. Register the new controller class using an extension in the new plug-in.
4. Test your controller.

Congratulations!

Congratulations, you just made a big step towards understanding how Eclipse works. Plus, you've refreshed your knowledge on Turing Machines along the
way. “2 Eclipse is an industry standard technology, and having experience programming against it is a valuable skill for you.

If you have any comments and suggestions for improvement concerning this tutorial, please don't hesitate to tell us about them!
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